OLYMPUS

DIGITALVOICE
RECORDER

DS-4000

ONLINE
INSTRUCTIONS

Thank you for purchasing an Olympus
Digital Voice Recorder.
Please read these instructions for information
about using the product correctly and safely.
Keep the instructions handy for future reference.

To ensure successful recordings, we recommend that
you test the record function and volume before use.
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Safe and Proper Usage

Before using your new recorder, read this
manual carefully to ensure that you know
how to operate it safely and correctly. Keep
this manual in an easily accessible
location for future reference.

Important Safety Precautions

Certain symbols are used in the user’s
manual and on this product to help protect
users, their surroundings, and their
property from possible injury or damage.
Please familiarize yourself with the
following definitions and meanings for
each symbol before reading the
precautions.

Signifies danger which
may result in serious
injury or death.

Indicates items or actions
which may cause serious
injury or death.

Warning

Indicates items or actions
which may resultin damage

Caution ©r personalinjury.

Symbols prohibiting a specific action

- Do not
® Prohibited @ disassemble

Symbols requiring a specific action

Unplug from
0 Mandatory % power outlet

Convention Used In this Manual

* The word “card” is used to refer to the xD-
picture Card.

* The word “DSS Player” is used to refer to
the DSS Player Pro Dictation Module in
Windows environment and DSS Player for
Mac in Apple Macintosh environment.

* The Notes at the bottom of a page are used
for additional information, exceptions, or
related events.

¢ Words in uppercase form such as PLAY or
REC are used to describe a function, button,
or switch position on the recorder.

* The icon UM indicates that feature or setting
can be modified by Professional Olympus
Authorized Dealer only.



General Precautions

® Do not leave the recorder in hot, humid
locations such as inside a closed
automobile under direct sunlight or on
the beach in the summer.

® Do not store the recorder in places
exposed to excessive moisture or dust.

® Do not use organic solvents such as
alcohol and lacquer thinner to clean the
unit.

® Do not place the recorder on top of or
near electric appliances such as TVs or
refrigerators.

@ Avoid recording or playing back near
cellular phones or other wireless
equipment, as they may cause
interference and noise. If you
experience noise, move to another
place, or move the recorder further away
from such equipment.

@ Avoid sand or dirt. These can cause
irreparable damage.

@ Avoid strong vibrations or shocks.

@ Do not disassemble, repair or modify the
unit yourself.

® Do not operate the unit while operating
avehicle (such as a bicycle, motorcycle,
or go-cart).

® Keep the unit out of the reach of
children.

<Warning regarding data loss>

Recorded content in memory may be
destroyed or erased by operating
mistakes, unit malfunction, or during
repair work.

It is recommended to back up and save

important content to other media such as
a computer hard disk.

Batteries/Rechargeable
Battery Pack (BR402)

A Danger

* Do not solder lead wires or terminals
directly onto a battery or modify it.
* Do not connect the ® and © terminals
together. This may cause fire,
overheating or electric shock.
When carrying or storing the battery
(BR402), be sure to put it in the provided
case to protect its terminals. Do not carry
or store the battery with any metal
objects (such as key rings). If this
warning is not followed, fire, overheating
or electric shock may occur.
Do not connect the batteries directly to
a power outlet or a cigarette lighter of
an automobile.
Do not insert the batteries with their®
and © terminals reversed.
If any liquid from a battery gets into your
eyes, promptly wash it off with clean
water and consult your doctor at once.
¢ There is a hole from which gas escapes on
the @ terminal. Do not cover or block it
(BR402).

/\ Warning

* Batteries should never be exposed to
flame, heated, short-circuited or
disassembled.

* Do not attempt to recharge alkaline,
lithium or any other non-rechargeable
batteries.

* Never use any battery with a torn or
cracked outer cover.



e Keep batteries out of the reach of
children.

¢ If you notice anything unusual when
using this product such as abnormal
noise, heat, smoke, or a burning odor:

@ remove the batteries immediately while
being careful not to burn yourself, and;

(@ call your dealer or local Olympus
representative for service.

* Do not expose the rechargeable batteries
to water. Do not allow water to contact
the terminals.

* Do not remove or damage the battery
insulating sheet.

* Do not use the batteries if you find
something wrong with them such as
leakage, color change or deformity.

¢ Unplug the charger if the charging is still
incomplete after the specified time it
should take.

¢ Should any battery liquid get on skin or
clothing, promptly wash it off with clean
water.

* Keep batteries away from fire.

/\ Caution

* BR402 rechargeable batteries are
exclusively for use with Olympus digital
voice recorder DS-4000. Do not use them
in combination with other equipment.

* Do not subject batteries to strong
shocks.

* Do not use with other types of batteries,
or with batteries that have different
voltages or brand names.

e When using more than two batteries,
charge them at the same time.

* When using new batteries, or batteries which
have not been used for a long time, be sure
torecharge them even if they were only used
for a short period of time.

Battery Charger (Cradle)

/\ Danger
® ¢ Do not attempt to use this charger

with anything other than Olympus
Ni-MH batteries. Using it in
combination with other batteries
may cause fire, explosion, leakage
or overheating.

Do not put the charger in water.
Using it when wet orina humid area
(such as a bathroom) may cause
fire, overheating or electric shock.

N
* Do not use the charger with
® batteries that have been
inserted with their ® and ©
terminals reversed. This may
cause fire, explosion, leakage,
overheating or damage to
batteries.
SV

Never modify or disassemble
the charger. This may cause
fire, overheating, electric

Do not .,
shock or injury.

disassemble

/\ Warning

* Do not use the batteries if you
find something wrong with

them such as deformity or
leakage. This may cause
explosion or overheating.



e Do not insert metal wires or
similar objects. This may cause
fire, overheating or electric
shock.

e Keep out of the reach of
children. Do not let children
use this product without adult
supervision.

N
0

/\ Caution

* Do not charge continuously for
more than 3 hours. This may
cause explosion, fire, leakage or
overheating of batteries.

Be sure to charge batteries within the
temperature range of 0°C - 40°C/32°F
-104°F. If not, there may be explosion,
fire, leakage or damage to batteries.

Do not put anything heavy on the
charger or leave it in an unstable
position or in a humid place. This
may cause explosion, fire, leakage,
overheating, electric shock or injury.

Do not touch the charger for too
long when using it. This may cause
a serious low-temperature burn.

If charging does not finish (or if the
charge indicator light does not go
off) after three hours, the charger
may break. If this occurs,
disconnect the power plug and
consult your nearest Olympus
dealer or customer support center.

* Do not use or store the charger in/
on an unstable place, such as a
television set, etc. If it falls, it may
cause injury or break.

© eV Ve Y

AC Adapter

/\ Danger

* Be sure to use the charger with
0 the proper voltage (AC 100 - 240

V). Using it with other voltage
levels may cause fire, explosion,
overheating, electric shock or
injury.

For safety, be sure to unplug the
charger from the outlet before
performing maintenance or

Unplug from . .

poweroutlet  Cleaning. Also, never plug in or
disconnect the power plug with a
wet hand. This may cause electric
shock or injury.

/\ Warning

¢ Do not attempt to disassembile, repair or
modify the AC adapter in any way.

* Keep foreign objects including water,
metal, or flammable substances from
getting inside the product.

¢ Do not moisten the AC adapter or touch
it with a wet hand.

¢ Do not use the AC adapter in the vicinity
of flammable gas (including gasoline,
benzine and lacquer thinner).

In case

e ... the internal parts of the AC adapter
are exposed because it has been
dropped or otherwise damaged:

¢ ... the AC adapter is dropped in water, or
if water, metal flammable substances or
other foreign objects get inside it:

¢ ... you notice anything unusual when
using the AC adapter such as abnormal
noise, heat, smoke, or a burning odor:
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@ do not touch any of the exposed parts;

(@ immediately disconnect the power
supply plug from the power outlet, and;

® call your dealer or local Olympus
representative for servicing. Continued
use of the AC adapter under these
circumstances could result in electric
shock, fire or injury.

/\ Caution

N

<

Unplug from
power outlet

0

* Do not use the charger if the
power plug is damaged or the
plug is not completely
connected to the outlet. This
may cause fire, overheating,
electric shock, short circuit or
damage.

Unplug the AC Adapter from AC
outlet when not using. If this
precaution is not followed, fire,
overheating or electric shock may
occur.

Make sure to hold the plug when
removing the power plug from
the outlet. Do not bend the cord
excessively or put a heavy
object on it. This may cause fire,
overheating, electric shock or
damage.

0

N

¢ If something appears to be
wrong with the charger, unplug
the charger from the outlet and
consult your nearest service
center. Using the charger may
cause fire, overheating, electric
shock or injury.

Do not use or keep the charger
in very hot places, such as in
direct sunlight, in a closed car
on a sunny day, near a heater,
on an electric carpet, etc. Do not
use the charger if something is
covering it (such as a blanket).
This may cause fire, explosion,
leakage or overheating.



Main Features

Slide switch operation for ease of use and
fast response.

Dual function cradle, docking station, for
recharging of Ni-MH Rechargeable Battery
Pack (BR402) (== P.13)* and for downloading
data from the recorder to a PC (== P.58).

Two Programmable buttons A and B
(= P.18).
Recording and storing voice in DSS format.

Two recording modes, SP (Standard
Playback) mode or LP (Long Playback)
mode (= P.35).

Five folders and up to 199 files/folder, for a
maximum of 995 recordings (x= P.23).

Built-in Variable Control Voice Actuator
(VCVA) function (= P.27).

USB Audio Device, recorder can be used
as a USB microphone or USB speaker
when connected to a PC (= P.69).*?

Large LCD screen with backlight.
Multi-level priority setting (== P.42).
DSS Player software included (== P.48).

Hands-free recording function when used with
the optional foot switch (RS25/26) (= P.28).

*' Available only with the supplied Ni-MH Rechargeable
Battery Pack (BR402).

*2 Do not use with Windows 98 as computer operation may
become unstable.

IBM and PC/AT are the trademarks or registered
trademarks of International Business Machines
Corporation.

Microsoft and Windows are registered trademarks
of Microsoft Corporation.

Apple, Macintosh, iMac, eMac, Mac, and PowerMac
are trademarks or registered trademarks of Apple
Computer, Inc.

Intel and Pentium are registered trademarks of Intel
Corporation.

Adobe and Acrobat Reader are registered
trademarks of Adobe Systems Incorporated.
Other product and brand names mentioned herein
may be the trademarks or registered trademarks of
their respective owners.
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xD-Picture Card

The xD-Picture Card is a removable recording media.

Compatible Cards

A
The removable card can be used to store different OLYMPUS @

kind of data. Since the card has larger memory xD-Picturs Card
capacity than a diskette, it can be used to transfer
data between different PCs. The recorder supports

cards with memory capacity between 16 to 512 MB. (O Index area @ Contact area
You can write Comes into contact
down the card’s with the recorder’s
contents. signal read contacts.

Memory Sizes of Cards and Approximate Recording Times*'

Memory Size SP Mode LP Mode
16MB 2 hr. 35 min. 5 hr. 30 min.
32MB 5 hr. 10 min. 11 hr. 05 min.
64MB 10 hr. 25 min. 22 hr. 20 min.

- - *1: Available recording time for one continuous file.
128MB 20 hr. 55 min. 44 hr. 45 min. Available recording time may be shorter if many
256MB 42 hr. 00 min. 89 hr. 40 min. short recordings are made.

- B *2: Total recording time of two files. The maximum
512MB 84 hr. 05 min. 179 hr. 30 min.*2

recording time per file is 99 hours.

Notes

* When initializing (formatting) a card, confirm that no necessary data is stored on the card beforehand.
Initialization completely erases the existing data on the card.

* Cards used in a recorder must be formatted in the same recorder first unless formatted with a
CAMEDIA series Olympus digital camera. Card may not perform as expected when formatted by a
different device.

* The card has a service life. When reaching the end of its life, writing or erasing data on the card will be
disabled. In this case, replace the card.

« If you use a PC card adapter compatible with the card to save or delete some data on the card, the maximum
recording time on the card may be decreased. To recover the original recording time, initialize/format the
card in the recorder.

] 0 * Olympus will not be held liable for any data corruption or loss due to misuse of the media card.



Identification of Parts
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(1 EAR jack 12 ERASE button

(@ MIC jack @3 Display (LCD panel)

(3 Built-in microphone Record/Play indicator lamp

(@ NEW button 19 POWER (ON/OFF) switch

(® Slide (REC/STOP/PLAY/REV) switch VOLUME (+) button

(® FF (Fast Forward) button () VOLUME (-) button

@ REW (Rewind) button Card cover lock

Built-in speaker Card cover

(® MENU button 0 Battery cover

B button (Programmable) @) PC (USB) terminal/Cradle attachment

@D A button (Programmable) point

11
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Display (LCD Panel)

77

© Battery indicator

@ Folder

© Priority indicator

O Current file number

@ Total number of recorded files in
the folder

O Erase lock indicator

@ Character Information display

O Microphone sensitivity display

© VCVA (Variable Control Voice
Actuator) indicator

@ Record mode indicator

12



Installing Batteries

| Ni-MH Rechargeable Battery Pack (BR402) |

Lightly press down on the arrow and slide the
battery cover open.

Insert Ni-MH Rechargeable Battery Pack,
observing the correct polarity.

Close the battery cover completely.

The battery needs to be charged when you use the recorder
for the first time after purchase (= P.15).

Recharging batteries
The battery indicator on the display changes as the batteries
lose power.

] > e - N > ]
When € N appears on the display, charge the batteries as
soon as possible.
When the battery is too weak, the recorder shuts down and
“BATTERY LOW?” appears on the display.

Notes

* Removing the battery pack while the recorder is in use may corrupt the file. If you are recording into a file
and the battery run out, you will lose your currently recorded file since the file header will not be written. It
is crucial to charge the batteries once you see only one hash mark in the battery icon.

* Remove the battery pack if you are not going to use the recorder for an extended period of time.

* You can charge the battery while the recorder is in operation.

saueneg Buijeisul =
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| AAA alkaline batteries|

Lightly press down on the arrow and slide the
battery cover open.

Insert two AAA batteries, observing the correct
polarity.

Close the battery cover completely.

Replacing batteries
The battery indicator on the display changes as the batteries
lose power.

o > N - €3 - T3

When {_ ] appears on the display, replace the batteries as

soon as possible.
When the batteries are too weak, the recorder shuts down

and “BATTERY LOW” appears on the display.

Notes

* Be sure to turn OFF the recorder before replacing the batteries. Removing the batteries while the
recorder is in use may corrupt the card. If you are recording into a file and the batteries run out, you will lose
your currently recorded file since the file header will not be written. It is crucial to replace the batteries when
one hash mark in shown in the battery icon.

* Be sure to replace both batteries at the same time.

* Never mix old and new batteries, or batteries of different types and/or brands.

« If it takes longer than 1 minute to replace dead batteries, you may have to reset the time when you load new

batteries.
* Remove the batteries if you are not going to use the recorder for an extended period of time.



Charging Battery

You can charge the Ni-MH Rechargeable Battery Pack in the recorder when you set the recorder in the
cradle. The battery is usually shipped partially charged. You need to charge the battery before first use.

Connect the AC adapter or USB cable to the

Kioneg Buibieys =

AC adapter cradle.
AC cable For connection procedures, see P.54.
ﬁ&nec‘or When using the adapter for charging, connect the power plug
w to the charger’s AC connector.

Turn ON the recorder and, remaining the slide
switch at the STOP position, set it vertically in
the cradle.
CHARGE indicator lamp glows red and the charging starts.

The plug type varies The lamp goes out when the charging is complete.

depending on the

country where sold.

Recommended temperature range for use
Discharging (when using appliance): 0°C - 50°C/32°F - 122°F
Charging: 0°C - 40°C/32°F - 104°F
Storage: —20°C - 30°C/—4°F - 86°F
Using the batteries outside the above temperature range may
result in declining efficiency and shorter battery life.
In order to prevent battery leakage or rust, remove the batteries
from the products when you will not be using them for a long time,
and store them separately.

Notes

* Charge the battery often for first few uses. Battery performs better after several full charge/discharge cycles.
Batteries other than the supplied battery cannot be charged.

If you charge the battery right after charging is complete, it will take only few minutes to charge the battery.
The PC must be ON when charging battery via the USB cable connection.

Charging battery via the USB cable connection may not be successful depending on the power supply
capacity of your PC. Use the AC adapter instead.

If you change the recorder to AUDIO device while charging battery only via the USB cable connection, charging may
stop.

Do not set or remove the recorder from the cradle while it is in operation. ] 5
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Information Regarding Rechargeable Batteries

These batteries are exclusively for use with Olympus voice recorder DS-4000. Never use them
in combination with other equipment.

Discharging

Batteries self-discharge while they are not in use. Be sure to charge them regularly before
use.

Battery life

Charging and discharging are possible for approximately 500 times depending on usage.

|0perating temperature

Batteries are chemical products. Battery efficiency may change even when operating within
the recommended temperature range, but this is not a malfunction.

Notes

This charger is designed to fully charge batteries regardless of their energy level. However, for best

results when charging newly purchased batteries or batteries that have not been used for a long time

(more than one month), It is recommended to fully charge the batteries, then discharge them. Repeat

two or three times.

* When you dispose dead batteries always observe the laws and regulations regarding the disposing of such
items.

« If Ni-MH rechargeable batteries are not fully discharged, protect against short-circuiting (e.g. by taping the
contacts) before disposing.

@ Batterij niet For customers in Germany
weggooien, maar Olympus has a contract with the GRS (Joint

inl Is KCA Battery Disposal Association) in Germany to

Inleveren als . ensure environmentally friendly disposal.



Turning ON the Recorder

With the battery charged in the recorder and the card
inserted properly, the recorder is ready to work.

While the power switch on the back of the recorder is in
the OFF position, none of the buttons or switch on the
recorder will be active. Slide the power switch to the ON
position to activate the recorder.

Power Save Mode

When the recorder is ON but not in use for 10 minutes, by default, it will switch to power save mode
automatically. To reactivate the recorder again, press any of the buttons on the recorder.

SpOJ\ SABS J1OMOd /19pJ023Y dy} NO Butuing =
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Dealer Option ltems

Some additional options can be set by your Olympus Professional Dealer.
These additional and customizable options are as follows:

@ Setting for “beep” sound. For details on the functions and operation
@ Setting for NEW button operation. of dealer optional items, consult your
® Setting for REC button operation. Olympus dealer.

® Setting for Splash screen.

® Adding/removing of user defined fields.
® Switching the display languages.

® Changing the number of folders.

® Assigning functionality to A, B buttons.
® Assigning functionality to the foot switch.
® Setting time for Power save mode.

A, B Programmable Buttons

By default, the two buttons labeled A and B are programmed as follows:

A button: FOLDER button
B button: PRIORITY button

The following functions can be assigned to A and B buttons.

- INDEX button

- FOLDER button

- DISPLAY button

- Recording Mode setting button

- Microphone Sensitivity setting button
- VCVA setting button

- PRIORITY setting button

A Programmable
button
B Programmable
button




Setting Time/Date (TIME&DATE)

Setting the correct time and date on the recorder is very important since every file recorded on
the recorder will have the date and time information as part of the file header. This will simplify
the file management aspects later on.

The hour indicator will flash automatically when you load batteries before using the
recorder for the first time, or after the recorder hasn’t been used for a long time.

A button —
(switching
the data

displayed)

FF/REW —
button

(alters a choice)

MENU
button
(accepts a
choice and
moves on to the
next item)

Set the hour.
@ Press the FF button or REW button to
set the hour.
(2 Press the MENU button to accept the hour.
* You can choose between 12 and 24 hour
display by pressing the A button while
setting the hour and minute.

Example: 5:45 P.M.

5:45 PM «— 17:45
(Initial setting)

Set the minute.

@ Press the FF button or REW button to
set the minute.

(@ Press the MENU button to accept the minute.

Set the year.
@ Press the FF button or REW button to
set the year.
(@ Press the MENU button to accept the year.
* You can choose a different date format by
pressing the A button while setting the date.

(3LvazamiL) srea/ewiL bunies =
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Example: March 14, 2004

3M 14D 2004Y (Initial setting)
\:

14D 3M 2004Y
\2

2004Y 3M 14D

Set the month.

@ Press the FF button or REW button to
set the month.

(@ Press the MENU button to accept the
month.

Changing the Time/Date

Set the day.

@ Press the FF button or REW button to
set the day.

(@ Press the MENU button to accept the
day’s date.

Notes

¢ If you move the slide switch to a position other
than STOP mode, the recorder will save the items
that were set to that point.

*You can set the time and date from your PC using DSS
Player software (r= P.48).

Press the MENU button.
The menu appears (= P.35).

Press the FF or REW button until =
“TIME&DATE” flashes on the display.

[:SUE MENU ] |

[ TIMERDATE
LOCK
BEEP

Press the MENU button.

Time/Date screen appears. The hour
indicator flashes, indicating the start of the
Time/Date setup process.

Follow the same steps starting at step 1 in
“Setting Time/Date” (x= P.19).

Press and hold the MENU button for

1 second or longer to close the

menu.



Inserting and Ejecting a Card

Inserting a Card

Slide the card cover lock in the direction

indicated by the arrow.

The card cover is unlocked and the message “CARD COVER
IS OPEN”" appears on the display. When this message
appears, the power is switched off automatically.

Face the card the correct way and insert it into

the card slot as shown in the diagram.

* Insert the card keeping it straight.

* The card stops with a click when it is inserted all the
way.

¢ Inserting the card the wrong way or at an angle could
damage the contact area or cause the card to jam.

¢ If the card is not inserted all the way, data may not be
written to the card.

pies e Bupoalg pue Bupasul =

Close the card cover securely.

Card inserted fully into the slot

The recorder sounds beeps* and the message “PLEASE
WAIT” on the display flashes for seconds.

Card not inserted fully into the slot

When the card cover is closed, the message “INSERT
CARD” on the display flashes for a few seconds. Pressing
any button will sound beeps* and flash the message
“INSERT CARD” again.

* When the system sounds are enabled.

Notes

 If an unformatted card is inserted, the recorder automatically
displays the menu to menu format option (x= P.46).

* Never use any card in the recorder unless it has been formatted on
this unit or on a CAMEDIA series Olympus digital camera (s= P.46). 2]
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Ejecting a Card

Slide the card cover lock in the direction

indicated by the arrow.

The card cover is unlocked and the message “CARD
COVER IS OPEN” appears on the display.

The power is switched off automatically.

Push the card inward to unlock it, and let it
eject partially.
The card is visibly out of the slot and can be removed safely.

Hold the card straight and pull it out.

Releasing your finger quickly after pushing the card inward may
cause it to eject forcefully out of the slot.



Recording

By default, the recorder has five folders, A, B, C, D and E. These five folders can be selectively
used to distinguish the kind of recording; for example, Folder A might be used to store private
information, while Folder B might be dedicated to holding business information. You can use
your DSS player to change a folder name (== P.64). Up to 199 messages can be recorded per
folder.

All recordings made in any of the folders will be in Digital Speech Standard (DSS) format. By
default, the RECORD function is configured to record at the current position (overwrite). However,
that can be changed to any of the following settings:

* Append: Appends the recording to the end of the current file.

¢ Insert: Inserts the recording at the current position in the file.

* Overwrite: Overwrites the recording starting at the current position in the file.

New Recording

Create a new file to record in.

Press the NEW button to create anew [
file. Ol i T

@ Current recording mode ©TAUTHOR A
" NEW F11E
(® New file number REMA I N :
4H33M128

(© Selected Author ID

Move the slide switch to the REC "F’E,Z]
position to start recording. EEL 7Y
The record/play indicator lamp glows red. AUTHOR. & s
Aim the microphone at the sound source. @’DEDH]SD%M%S

@ Current recording time
(®© Remaining recording time

Move the slide switch to the STOP
position to stop recording.

If you want to append additional recordings to
the same file, move the slide switch to the REC
position again.

Press the NEW button to close the
file.

Buipiooay =
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Notes

* A beep will sound when the remaining recording time reaches 60 seconds, 30 seconds, and 10 seconds
while recording.

* “MEMORY FULL” or “FOLDER FULL” will be displayed when the memory or folder capacity is full. Delete
any unnecessary files before recording any further (== P.31) or transfer dictation files to your computer
using DSS Player Software (= P.55).

* You cannot select a different recording mode (SP or LP) than that of the original file when appending
recording.

Review Recording

Move the slide switch to the REV position while recording, then move the slide switch to the PLAY
position when you want to start playback.

The recorder plays up to the end of file, then stops.

You can overwrite or append additional recordings in the same file from that point.




Overwrite Recording

You can overwrite a previously recorded file from any point within the file.
Note that the overwritten recordings will be erased.

1,23

Select and play the file you want to

overwrite.
Stop playback at the starting point of
overwrite.

Move the slide switch to the REC @ﬁ :]
o . "
pOSItIOI’I to start ovenertlng. o110 /133
The record/play indicator lamp glows red. AUTHOR A s

14M00S

0 TRRe

Move the slide switch to the STOP
position to stop overwriting.

Note
You cannot select a different recording mode (SP, LP) than that of the
original file before overwrite recording.

Bupiooay =
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Insert Recording

Additional recording can be inserted into previously recorded file.

Select and play the file you want to
insert an additional recording into.

While playing the file, press the (&5 =)
MENU button to insert an additional g | 1334
recording. AUTHOR A

. 00N19S
“INSERT ?” appears on the display. AT

13,4+

Move the slide switch to the REC &9 )
position to start inserting an ocr :'3"‘/&
additional recording. AUTHOR & 15
The record/play indicator lamp glows red. N
“INSERT REC” and the remaining recording Y
time will alternate on the display.

AUTHOR A

\ AL
(TGN

Move the slide switch to the STOP
position to stop inserting the
additional recording.

Notes

* If you place the slide switch in the STOP position for more than two
seconds while moving the slide switch from the PLAY position to the
REC position, the Insert recording will be canceled.

* The recording time and date of the file is updated to the time and date
of the inserted recording.

* You cannot select a different recording mode (SP, LP) than that of the
original file before inserting.



Using the Variable Control Voice Actuator (VCVA)

When the microphone senses that sounds have reached a preset actuation volume level, the
built-in Variable Control Voice Actuator (VCVA) starts recording automatically, and stops when
the volume drops below the actuation level.
The VCVA feature helps extending recording time and conserves the memory by turning off recording
during silent periods. This helps make the playback, with no lulls or dead space, more efficient and convenient.

FF / REW

button

Set the VCVA in the menu to ON
(== P.35-36).

Move the slide switch to the REC
position to start recording.

When the sound volume is lower than the preset
actuation sound level, recording automatically stops after
1 second approximately, and “STANDBY” flashes on
the display. The record/play indicator lamp glows when
recording starts and flashes when recording pauses.

Adjust the Start/Stop Actuation
Level

Press the FF or REW button to adjust the
actuation level during recording.

The VCVAlevel can be setto any of 15 different values.
The higher the value is, the more sensitive the recorder
can react to sounds. At the highest value, even the
faintest sound will activate recording.

The VCVA actuation level can be adjusted
according to the ambient (background) noise.

(@ Start level (varies according to the sound
volume being recorded)

® Level meter (moves to the right/left according
to the set level)

AUTHOR ID
1H25M01S

TANDBY
I ]

(ST
IV

AUTHOR ID

N[}

Notes
* The start/stop actuation level also varies depending on the selected
microphone sensitivity mode (= P.35).
* To ensure successful recordings, prior testing and adjustment of the start/
stop actuation level is recommended.

(VADA) J01en}oy 8910A [013U0D BlqeLie ay} Buisn =
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Hands-free Recording

The recorder can be used as a hands-free recording device. To setup the recorder for hands-
free operation, connect the optional Olympus foot switch (RS25/26) to the back of the cradle
and place the recorder in the cradle as shown in the diagram below.

The default settings of the foot switch
functions are as follow:

Default settings

Switch Press Pressand hold  Release
Left SW - REV PLAY
Center SW - REC STOP

Right SW NEW - -

Notes

* The Olympus foot switch (RS25/26) is sold
separately.

* Move the slide switch of the recorder to the STOP
position before connecting it to the cradle for
hands-free recording.

Recording Monitor

It is possible to monitor your recording by listening to the
recording while recording is in progress. Insert the earphone
plug into the earphone jack and use the VOLUME button
to control the volume level.

Zﬁﬂ_ Note
- VOLUME Insert the plugs to the end as shown in the illustration when

+) /() inserting the earphone or external microphone.
button




Playing

You can start playing a file at any point.

Select the file, then move the slide
switch to the PLAY position to start
playback.

The record/play indicator lamp glows
green.

(@ Current playback time
(© Total recording time of the file being

played

Press the VOLUME (+) or VOLUME
(=) button to adjust the volume.
The display shows the volume level. You
can choose between 0 to 30.

Move the slide switch to the STOP
position at any point you want to
stop the playback.

(o]

Ed
el 0t 3

FOLDER A
ooM!

133
058
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Playback Operation How to Cancel
functions

Fast Press the FF button once while stopped. Move the slide switch to a position
Forward other than the STOP position.

(FF) = The recorder starts the operation of

Rewind Press the REW button once while stopped.
(REW)

the set position.

Cue Hold the FF button while stopped or playing a file.

(CUE)

Release the button.

Review Hold the REW button while stopped or playing a file.

(REV)

Release the button.

Move the slide switch to the REV position.

Release the slide switch.

« If you press the FF button once while fast-forwarding or twice while stopped, the recorder will stop at the

end of the file (F.SKIP).

« If you press the REW button once while rewinding or twice while stopped, the recorder will stop at the
beginning of the file (B.SKIP). If the REW button is pressed within 2 seconds, the recorder skips to the

beginning of the previous file.



Erasing

Erasing a File
Erasing or deleting a file from any of the folder on the recorder is a very simple process.

Select the file you want to erase.

Press the ERASE button. =g
“FILE ERASE ?” flashes on the display for U' ! ,‘I,;,]
approximately 8 seconds. FOLDER A

Press the ERASE button once more

while “FILE ERASE ?” is flashing.
The display changes to “FILE ERASE !” and
erasing will start.

“ERASE DONE” is displayed when the file is
erased. File numbers will be reassigned

automatically.

ERASE DONE

Notes
« If the ERASE button is not pressed within the 8 seconds after “FILE

ERASE?” starts flashing, the recorder will revert to the stop status.
¢ An erased file cannot be restored.
* Locked files cannot be erased (= P.37).

Buisea =
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Erasing All Files in a Folder

All files in a folder can be erased simultaneously, except for locked files (= P.37).

Select any file in the folder, then
press and hold the ERASE button for
3 seconds or longer.

“ALL ERASE ?” flashes on the display for
approximately 8 seconds.

Buise.g =

Press the ERASE button once more
while “ALL ERASE ?” is flashing.

The display changes to “ALL ERASE !” and
erasing will start.

“ERASE DONE” is displayed when the files
are erased. Any locked files in the folder will
be reassigned new file numbers in ascending
order.

Notes

Al RASE ?

@
Eﬁ'ﬂ/aa

FOLDER A

ERASE DONE

* If the ERASE button is not pressed within the 8 seconds after “ALL
ERASE ?” starts flashing, the recorder will revert to the stop status.
* The erasing process may take up to 10 seconds. Do not interrupt this

process! Data will be destroyed.

32



Partially Erasing a File

You can erase a selected file in part.

Start playback the file you want to
erase partially.

Press the ERASE button at the point Y
to start erasing. 0o T T3
While playback continues, “PARTIAL AUTHOR A

ERASE” and the file length will alternate
on the display.

Press the ERASE button at the point
to end erasing.

The erase starting point (time) set in step
2 and the ending point (time) set in this step
will alternate on the display for 8 seconds.

45M00S
1H55M255

(o
E"-f 2

AUTHOR A

PARTIAL
ERASE

oL 34

AUTHOR A

START
ERASE

@Gs;]

AUTHOR A

Buisea =
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Press the ERASE button to confirm

erase.
The display changes to “PARTIAL ERASE!”
and erasing will start.

When “ERASE DONE” appears on the display,
partial erase is complete.

Notes

(T

EJ
01S

AUTHOR_ A
5M

PART | AL
ERASE |
(o]

4
M

AUTHOR_ A
5MO1

S
ERASE DONE

* |f the ERASE button is not pressed within the 8 seconds after “START”
or “END” starts flashing, the recorder will revert to the stop status.

* An erased file cannot be restored.
* Locked files cannot be partially erased (= P.37).



Menu List

[ Press the MENU button. |

-»| REC MODE Select SP or LP mode.
k3

Microphone sensitivity setting. Select between

MIC SENSE CONFERENCE (high-sensitivity mode) or

‘ DICTATION (low-sensitivity mode).

EXIT Exit MENU and return to STOP mode.
E
SUB MENU

Switches to the SUB MENU.

VCVA setting (==P.27). Select ON (enabled)
or OFF (disabled).

Locking files setting (=P.37). Select ON
L LOCK (locked) or OFF (unlocked).

System sounds setting. Select ON (enabled)
BEEP or OFF (disabled).

FORMAT Recorder formatting (= P.46).

Returns to the MENU.

CONTRAST I1_Ct)(l)3 1cg.ntrast adjustment. Select the level from

USB charge setting. Select ON (enabled) or
OFF (disabled).

Backlight setting. Select ON (enabled) or OFF
BACKLIGHT (disabled).

Time/Date setting. Hour, minute, year, month
~»{_TIME&DATE and day (=P.19).

Notes

USB CHARG.

« If you press the NEW button or hold the MENU button for 1 second or longer, during a menu

Press the FF
button or REW
button.

N

Press the
MENU
button.

setup operation, the recorder will stop and apply the items that were set to that point.

* The recorder will stop if you leave it idle for 3 minutes during a menu setup operation, when a

selected item is not applied.

* You can set the time and date on the recorder from your PC using DSS Player software (== P.48 ).

1s11 nuspy =
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Learning to Use the Menu

To navigate through the different options in the MENU, use the MENU List flow chart (== P.35) and
the following steps to modify or change any settings.

—
(]

1
=73

Press the MENU button.
The menu appears (== P.35).

Press the FF or REW button to highlight a menu
item you want to modify/change.

Press the MENU button to select that menu item.
The possible options for the menu item will be in view.

Press the FF or REW button to highlight an option
or setting.

Press the MENU button.
The highlighted option will be selected and the new setting
saved.

Press and hold the MENU button for 1 second or
longer to close the menu.



Locking Files (LOCK)

The file lock feature is very useful to protect important data from accidental erase. Locked files
are never erased except when the card is formatted (== P.46).

Select the file you want to LOCK,

press the MENU button.
The menu appears (== P.35).

Press the FF or REW button until &=
“LOCK” in SUB MENU flashes on the

display. LSuB vENU)
EEEP
FORMAT

Press the MENU button.
The file locking setup process begins.

Press the FF or REW button to @'_‘
!

lt\_J

!

choose between “ON” and “OFF”. @ ILil /s
ON: Locks the file and prevents it from FOLDER.A
being edited or erased. E___ON___4

OFF: Unlocks the file and allows it to be 9% J

edited or erased.
(@ Erase lock indicator

Press the MENU button to
select the option.

Press and hold the MENU button
for 1 second or longer to close the
menu.

Notes

* You cannot append, overwrite, or insert recordings into locked files
(= P.25-26).

¢ You cannot set index marks in locked files (== P.38).

(1907) sajid Buppoo =
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m Index Marks
| sl

In order to place an index mark in a file, the index function must be programmed to the A or B
button on the recorder.

Index marks can be placed in a file during recording or playback to provide a quick and easy to
identify important sections in the file.

Setting an Index Mark

Press the INDEX (A or B) button [@=

during recording or playback to set gnm@fﬂ_g]
an index mark. AUTHOR & s
An index number appears on the display. L

Locating an Index Mark

Hold the FF or REW button while
playing a file.

The recorder stops for 1 second when it
reaches the index mark.

Clearing an Index Mark

Locate the index mark you want to
clear.

Press the ERASE button while theindex (&
number appears for approximately 2 i

seconds on the display.
The index mark is erased.

Notes

* Up to 16 index marks can be set in a file. Attempting to set more index
marks will cause “INDEX FULL” to appear on the display.

* Index marks cannot be set or cleared in a locked file (= P.37).



LCD Display Information

Before using the DISPLAY function, it should be programmed to A or B button.

The LCD screen on the recorder can display 7 different formats of information by pressing the

DISPLAY button. This helps review and confirm different recorder settings and file information.

Press the DISPLAY (A or B) button.
The LCD display will switch view every time the DISPLAY button

is pressed.

While in Stop or Playback Mode

@ File length
Shows how long a file is.

(@ Time stamp
Shows the year, month, and
date that the file was recorded.

(3 Time stamp
Shows the time that the file was
recorded.

@ File comment*
Shows a comment added to the
file. (If there is no comment,
“----" will appears.)

Fos

UmcrE” ;3]

AUTHOR A

00MO00S
LENGTH :
2H27M58S

S

AUTHOR A

REC
3M1 6D2004Y

Fos

UnlcrE” ;3]

AUTHOR A
00MO00S

REC TIME:

3M16D 12:564

&
E@

AUTHOH A
00MO00S
COMMENT :

Fos

UnlcrE” ;3]

AUTHOR A

FoN
inc‘rE Vo3
AUTHOR A

WORKTYPE
SURGICAL

&

®ocr E" /33

AUTHOR A

1H50M12$

When pressing DISPLAY button, the recorder will cycle through
@ to@. Ifthere is nofile, only &), ®, @ will display instead.

@ Current time and date

Shows the current time and
date. (During the playback
operation, the “TIME & DATE”

or the counter appears.)

(® Work type ID

Shows the selected Work Type

ID.

(® Memory remaining

Shows the remaining recording

time.

* If a comment contains many

characters, it will sc
horizontally to display
complete comment.

roll
the
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While in Record Mode

Display @ and @ will alternate.

&= @ Recording level meter
3 ) Displays the sound input level graphically and the remaining time available for
O e /2 recording in countdown mode.

AUTHOR A

DDDDDDIIIIII

(2 Remaining memory bars
Displays the remaining time available for recording in bar mode and countdown
mode.

While Recording in VCVA Mode

Display D and @ will alternate.

o (@ VCVA recording level meter
gm -"-"/,3 Displays the sound input level graphically and the remaining time available for
oior recording in countdown mode. (“STANDBY” appears if the VCVA actuation level

AUTHOng',hﬁms isn’t reached.)

2H33M25S
I

) (2 Remaining memory bars
"'.i, Displays the remaining time available for recording in bar mode and countdown
ﬁ 34 mode.

AUTHOR A
25M01S
2H33M25S
ENEN F



While in Overwrite Record Mode

Display @ and @ will alternate.

o~
e

AUTHOR ID
10M25S8

!

[ ]
@mE’ 0/64

AUTHOR ID
10M258
14M00§

14M00S
I

@ Recording level meter

Displays the sound input level graphically, the current time and the length of
the file.

(2 Remaining memory bars
Displays the remaining time available for recording in bar mode, and the current
time and length of the file.

While in Insert Record Mode

Display @ and @ will alternate.

@
E

AUTHOR ID
1H95M01S

CINSERT R
I

&

AUTHOR A
25N01S

CHER

@ Recording level meter

Displays flashing “INSERT REC”, the sound input level graphically, and the
current recording time.

(2 Remaining memory bars

Displays flashing “INSERT REC”, the remaining time available for recording in
bar mode, and the current recording time.

uonew.oyu; Aejdsig @o1 =
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Setting Priority Levels

By default, B button is programmed with PRIORITY function.
You can set a priority level on each file recorded. You can choose between “HIGH” and “NORMAL.”
The default is NORMAL.

To Set a Priority Level on an Existing File

Select the file. & —
"
Qoer 1L /33
AUTHOR A
00M00S
LENGTH :
27M58S

Press the PRIORITY button to @@
choose between “HIGH” and oerl_!

u:' /33
“NORMAL”. AUTHO bwoos

sjona Ajaond Bumes =
N
|

Press the NEW button. o
Anew file is created. ®per

AUTHOR_A
NEW FILE

REMA | N:
2H33M12S

Press the PRIORITY button to %EE :]

choose between “HIGH” and Oocr 43433

“NORMAL".
REMA I N:

2H33M12S

Note
Priority level cannot be changed on a locked filed (= P.37).
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Setting Job Data

Every file recorded on the recorder will include the Author ID and Work Type as part of its header
information. To create multiple Author IDs and Work Types on the recorder, use the bundled DSS
Player software to create and upload a Job Data list (list of Author IDs and Work Types) to the
recorder.

By default the Author ID is set to “DS4000”.

Setting an Author ID
Turn ON the recorder. aw
When more than one Author ID exist on
the recorder, the ID list will be displayed.

AUTHOR C
AUTHOR D

Press the FF or REW button to
select the Author ID that you want
to assign to the recorder from the

ID list.
Press the MENU button to set the
ID.
All recordings made by the author during  ID List
the session will include the set ID as part 9
of the header information. T

T

2

T

S oo ]

ejeq qor Bumes =
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Setting a Work Type

<o
|

Press the NEW button while in T
STOP mode. Yoo _0'3"4'/133
When more than one Work Type ID exist \
o_n the recorder, the Work Type ID list will WORKTYEE €
display.

Press the FF or REW button to
highlight a Work Type from the
Work Type ID list.

Press the MENU button to select
the Work Type.
All recordings made with the new Work Type Type List

1D will h.alve the pew Work Type as part of the N Type 1
header information. __
T
T




m Setting Option ltem

The recorder can be programmed with additional user defined fields called Option Items.

Press the NEW button while in STOP
mode.

When programmed into the recorder, the Option
Item ID displays.

Use the alphanumeric characters set
displayed to set the Option Item ID.

Characters that can be entered are from 0 to PATIENT NO
9, fromAtoZ, and _.

Entering method

Press the FF/REW button:
Navigate through the character set.
Press the MENU button:
Enter the highlighted character and go on
to the next character.
Press and hold the MENU button:
Finish entering ID.
Press the ERASE button:
Erase the characters being entered.
If multiple Option Items are programmed into the recorder, each
Option ltem ID is entered in the same way described above.

When entering the final ID is done, the recorder switches to NEW
mode.

3456789[AB

Notes

* Each Option Item ID field can accept up to 20 characters maximum.

* If more than one Work Type ID exist on the recorder, the Option Item ID
displays after determining the Work Type.

way uondo Bumas =
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Formatting the Card (FORMAT)

Cards that have been used on non-Olympus devices, or cards that are not recognized by the
recorder, must be formatted before they can be used with the recorder. The Olympus xD-Picture
Card included with the recorder is preformatted and ready for use.

To familiarize yourself with the formatting process, read the steps below.

Press the MENU button.
The menu appears (= P.35).

Press the FF or REW button until (o]

“FORMAT” in SUB MENU flashes on

the display. }%ﬁ%}
CONTRAST

Press the MENU button to select
“FORMAT”.
The formatting process is selected.

Press the FF or REW button to ()]
highlight the “START” option.

[ FORMAT ]
CANCEL
START

Press the MENU button to confirm &
“START” selection.

“DATA WILL BE CLEARED” appears for [ FORMAT ]
approximately 2 seconds. DATA WL




Press the FF or REW button again
to highlight the “START” option.

SURE?
CANCEL
START

Press the MENU button again to |(&=

initiate the formatting process.
Formatting begins and “FORMAT!” flashes
on the display.

“FORMAT DONE?” displays when formatting = —
ends.

Notes

* The time required to format cards differs depending on the capacity of
cards. For example, formatting may take about 1 minute for 512 MB
card. Do not interrupt the formatting process by opening the card cover
or the battery cover. Doing so will damage the data or card.

* When the recorder is formatted, all the stored data, including locked
files, are erased.

« If an unformatted card is inserted, the recorder automatically displays
the format option in the menu.

(LYIWHO4) pieD auy Bunewoy =
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DSS Player Software

The DSS Player is a fully featured software tool that provides a simple to use but sophisticated
method of managing your recordings. Some of the features of the DSS Player are:

¢ Automatic download and backup of recordings from the recorder to a PC.

¢ Automatic distribution of recordings by e-mail or FTP to transcriptionists or other users.

* Automatic retrieval of typed documents, via e-mail or FTP, linking the document to the recording.

* Allows you to manage and change settings on your recorder.

¢ Allows you to play and edit recordings on your PC.

* When used with the recorder connected to a PC, direct recording on the PC is possible.

Make sure that your computer meets the minimum requirements listed below. Please check with your system
administrator or your Olympus Professional Dealer.

Minimum Requirement
{ Windows ]

PC: IBM PC/AT compatible PC

Operating System: Microsoft Windows 98/ 98SE/ Me/ 2000 Professional/
XP Professional, Home Edition

CPU: Intel Pentium 1l class 333 MHz processor or faster
(Processor 500 MHz or faster is recommended)
RAM: 64 MB or more (128 MB or more is recommended)
Hard drive space: 50 MB or more
Drive: 2x or faster CD-ROM, CD-R, CD-RW, DVD-ROM drive
Sound card: Creative Labs Sound Blaster 16 or 100% compatible sound card
Browser: Microsoft Internet Explorer 4.01 or later
Display: 800 x 600 pixels or more, 256 colors or more
USB port: One or more free ports

Audio I/0O terminals: Microphone input and earphone output or speaker



PC: Power Mac G3 233 MHz class processor or faster
iMac/ iBook/ eMac/ Power Mac/ PowerBook
(The computer must support a standard USB port.)

Operating System: Mac 0S 9.0-9.2.2/ 10.1-10.3

RAM: 64 MB or more (128 MB or more is recommended)
Hard drive space: 50 MB or more

Drive: 2x or faster CD-ROM, CD-R, CD-RW, DVD-ROM drive
Display: 800 x 600 pixels or more, 256 colors or more

USB port: One or more free ports

Audio I/0 terminals: Earphone output or speakers

Notes

* Do not use the recorder as a USB Microphone/Speaker on Windows 98 as computer operation may become
unstable. (Use only with Windows 98SE or later versions of the OS.)

* To use the voice recognition function with the recorder, use Windows 98SE or later versions of the OS (== P.65-66).

* Macintosh version does not support voice recognition software.

aiemyos Joheld SsSa =
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Installing DSS Player Software

Before you connect your recorder to your PC, you must first install the DSS Player software.
Make sure to exit all running applications, eject the floppy disk if you are using one, and logon as
administrator if you are running Windows 2000/XP (Professional only) or Mac OS X on the network.

Insert Olympus DSS Player CD into Insert Olympus DSS Player CD into
the CD-ROM drive. the CD-ROM drive.

The installation program will start Double-click the CD icon

automatically. h .
If the installation program does not start ?hﬁ:fccgge)z? Iadr?éss?:r;njd '(\)ASCOOSS 9x"and
automatically, browse your CD-ROM drive Py ’

and execute “setup.exe”.

Double-click the following icon.
Select the folder of which the language is

The installation Language Selection

dialog box appears.
Select the desired language.

Register user information.
Enter your name, company name, and
license ID number (serial number).

to be installed, and execute the installation
program in the folder.

Proceed with the installation
according to the instructions on the
screen.

The license ID number is printed on the
license ID card included inside the recorder
package.

Click the [Next] button. When a confirmation
dialog box appears, click the [Yes] button.

aiemyos Jake|d ssa Buijeisu] =

Proceed with the installation
according to the instructions on the
screen.

Note
Never install DSS Player in Mac OS 9.x system, when using DSS Player with Mac OS X. The device connected
when using the classic environment may not be recognized.

50



Uninstalling DSS Player Software

Exit DSS Player program.

Click the [start] button on the
taskbar.

Select [Add/Remove programs]
from the [Control Panel].
Alist of installed applications is displayed.

Select [Olympus DSS Player Pro],
then click the [Change/Remove]
button.

Proceed with the installation
according to the instructions on
the screen.

{ Macintosh
Exit DSS Player.

Delete the Preferences file.

Delete the [DSS Preference] file in the
following location.

(OS X)

Macintosh HD : User : Library : Preferences
(0S 9.x)

Macintosh HD : System Folder : Preferences

Delete the Executable file.

Delete the [DSS Player for Mac] file in the
location where you installed the file.

For OS X users, uninstalling has been
completed. For OS 9.x users, proceed to
step 4.

Delete the Driver file.

Delete the following files in the following
location.

System folder : Function Enhancement

[DSS 10USB Driver]
[DSS 10USB Shim]
[DSS 1USB Driver]
[DSS 1USB Shim]
[DSS FSUSB Driver]
[DSS FSUSB Shim]
[DSS USB Driver]
[DSS USB Shim]

asemyos 19held ssa Buijersuiun =

Delete the Help file.

Delete the [DSS Player for Mac Help] file
in the following location.

System folder : Help

Note
Uninstallation does not erase the stored dictation files. 5]



Using Online Help

For information on the DSS Player usage and features, refer to the online Help.

To start online Help:

» Click the [start] button, then select [All Programs], [Olympus
DSS Player], [Dictation Help].

* While DSS Player is running, select the [Help] menu,
[Contents].

* While DSS Player is running, press F1 on the keyboard.

djoH aunjup buisn =

* While DSS Player is running, select [DSS Player for Mac
Help] from the [Help] menu.

Note
Online Help is available after the DSS Player is installed.
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Connecting Recorder to PC

Be sure to install the DSS Player software before connecting the recorder to a PC. However, if
you do connect the recorder before or during the software installation, the “Add New Hardware
Wizard” appears. In this case, cancel the wizard by pressing the [Cancel] button in the wizard
screen and then install or continue the installation of DSS Player software.

You can directly connect the recorder’'s USB terminal to your PC, or use the cradle included in
the package (desktop holder).

Connecting to Your PC Using the USB
Cable

Turn ON the recorder (== P.17).

Insert end A of the USB cable to
your PC’s USB port or USB hub.

Make sure the recorder is in STOP
mode before attaching end b of the
USB cable to the terminal port of
the recorder.

If ‘REMOTE” is displayed on the recorder,
it indicates proper connections.

REHOTE

Once you connect the recorder to your PC, the recorder will
be powered through the USB cable. The batteries and/or AC
adapter will not be in use.

Notes

* NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.

* Some PCs and USB hubs may not supply sufficient power and the recorder fails to connect. Refer to your
PC User’s Manual regarding the USB port or USB hub on your PC.

* When using a USB hub to connect the recorder, always use a self-powered (AC adapter) USB hub.

* Make sure to push the cable connector all the way in. Otherwise, the recorder may not operate properly.

9d 0} Japiooay Bunoauuos =
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Connecting to Your PC Using the Cradle

| Place the recorder in the cradle |

Insert end A of the USB cable to your PC’s USB
port or USB hub.

Connect end b of the USB cable to the cradle.

Turn ON the recorder, then set the recorder in the

cradle.
If “REMOTE” is displayed on recorder, it indicates proper
connection.

| Disconnecting Recorder from PC

To avoid data corruption or loss, make sure that the recorder’s
record/play indicator lamp isn’t flashing, before removing the
recorder from the cradle or disconnect the cable from the
recorder terminal.

* Never touch the contact points at the bottom of the cradle, as that
may cause bad connection.

* With a PC connected, the recorder cannot be operated with the foot
switch (RS25/26). When connecting the recorder to a PC via the cradle,
remove the foot switch.



Running DSS Player

By default, connecting the recorder to your PC, will start the application automatically.

| Disabling automatic start |

Right-click the Device Detector icon @ in the System Tray in the lower right-
hand corner of the screen, then select “Settings startup application”.

Click [DSS Player Pro].
The check mark on [DSS Player Pro] disappears.

1 Start Windows.

Click the [start] button, then select [All
Programs].
All program menu will be displayed.

Select [Olympus DSS Player Pro], then click
[Dictation Module].

Note

If you connect the recorder before installing DSS Player,
the “Add New Hardware Wizard” dialog box will open. If this
happens, click [Cancel] to exit the wizard, then install the
DSS Player software.

1ofeld ssqa Buluuny =
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Start your Macintosh. eoe Applcatins =
© & mEu = 4 ¢
Back  Farmard View Compwier  Home  Favorites  Appliacans
Connect the recorder to your PC. M[f:‘“ m},',‘m s
For cable connection instructions, see = a
“Connecting to Your PC Using the USB caieiuar s ot
Cable” (= P.53). 3 _ ®
Double-click the [DSS Player for e o e
Mac] folder. B8 E. .E.
The DSS Player for Mac folder opens.

Double-click DSS Player.
DSS Player for Mac launches.

Note
DSS Player for Mac does not have the automatic start function.



Window Names

Z Dictstien Mo w ] *Main screen is displayed
o S Yom T Coind MomBrompt tee : when DSS Player is started
e ed x EBbhOIE - v @ m d-MmE 9 % Bu-

—»»lﬁﬁ ’ LB

i

i

©_

Oxtatoon Wirdom
[ e e

o -

Vot 3 mermsama

V| o Nt | Q3 et e

@
ok o 8 .
@ Playback Control Bar (3@ Device Tree View
Provides the control buttons to play and stop Displays the directory structure of the folders in
dictation files. the recorder.
(@ Dictation Tree View (@ Dictation List View
Displays the directory structure of the DSS, Displays the dictation files in the folder selected
WAVE (Windows only) and AIFF (Macintosh in@ and ®.

only)-format files stored on your PC’s hard disk.
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Downloading from Recorder to PC

There are 3 download options to transfer dictation files from the recorder to the PC:
* Download Selected Files
Download one or several dictation files to your PC.
* Download Folder X (X is any of the seven folders A to G)
Download all the dictation files in one folder.
* Download All
Download all the dictation files stored on the recorder to your PC.

The following is an explanation of “Download Selected Files”. For explanations of “Download
Folders” and “Download All”, refer to Online Help.

Download Selected Files e
[} Ds-4000 (DS4000)

Select the folder. — —}g

From the Device Tree View, select the folder that Ej:z:i
contains the dictation file you would like to download.

Folder D
The illustration shows that Folder A is selected. Folder £

[ Folder F
(@ Folder 5

Total of 3 messages

Select the dictation file.

Select the dictation file you would like to > (=5 % %

download from the Dictation List View. To §

select more than one file, hold either the @l

[Ctrl] or [Shift] key and select desired files.  —

The illustration shows that one dictation 7

file is selected. 7
7

File ame Authar Wark Type Created Date
oo 12125 o
12/24j2003 6:30,

12(24/2003 6:29..,




Download the dictation file. # Dictation Moduls - DS-4000 (D54000)
From the [Download] menu, click | & Ve Too REGEE vote Recoanton 1o

[Download Selected Files]. O -
-3 L-.i. %
i)
[ Wok Ty Crested Dote
ChrliShdt e
3 / (G roker | pon upond Temekres. . T

3 Foder ©

CE FORRTE | e i Send Job Dt

LR Poier | oot meconder Manu

Download complete. Downloading

Do not disconnect the USB cable while

the record/play indicator lamp on the . : \
recorder is flashing. Disconnecting the () -
USB cable when the recorder indicator -

lamp is flashing will result in data loss or DS400002,dss

corruption.
P ( ] Cancel

Remaining 3539 K bytes
You can change the download destination folder
by changing the folder properties in the Download
Tray. Right-click the folder and make the necessary
changes under [Properties].
To change the download options and filename
format, check the [Tools] menu, [Options].

9d 01 JopJ02ay woiy Buipeojumog =

Notes

* NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.

* Depending on the size of the dictation file and your PC, it may take some time to download the files.

* The downloaded files will be stored in the download tray folder that corresponds to the folder in the recorder.
(Example: A dictation file downloaded from Folder A will be stored in download tray A on your PC.)

« If adictation file already exists on your PC with the same name, date and time recorded, the new file will not
be downloaded.
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Playing a Dictation File

Select the folder.
Select the folder where the dictation

file resides. |
Select the dictation file. ad [ |m | » | »» | %
Select the dictation file to play from J

the Dictation List View.

Play the dictation file. 2 & Downi¥id Tray ! FileName /W Adthor
Click the [i® | (play) button in the Falder A 7 400001.dss  D54000
Playback Control Bar or double-click Folder B 7 (i]DS40000Z.dss  DS4000
the file.

Other playback control bar such as Rewind, Fast Forward, Stop, Speed Control, Volume Control,
Time Axis and Index Skip are also available on the Playback Control Bar.

The DSS Player can playback voice through the recorder speaker. The recorder must be connected
to the PC, and the USB Audio feature must be enabled on the recorder. See “USB Microphone/
USB Speaker (USB AUDIO)” (= P.69).

File Name Format
File names are assigned in the following manner.

DS400001.dss

L Extension
File number ...... A serial number automatically assigned by the recorder.

Author ID...The ID that has been set on the recorder. The default ID is “DS4000”. The Author ID
can be modified with DSS Player (= P.63).



Uploading from PC to Recorder

DSS Player enables you to upload DSS dictation files from your PC to the recorder.

Select the folder. i X . -# Dictation Module - Download TrayiFolder A\DS400001. dss
Select the folder where the dictation file T T ot T
to upload resides. . . Dornload Folder &
P : & 4 Dowirload Folder B &
1 1 1 Download Folder C
Select the_ dlc_tatl_on file. T i b
Select the dictation file to upload from the - Dovnload Folder E
Dictation List View, then select [Download ; R T
menu, then [Upload Files] or click the [ = 3 itstion Folder | Dowinload Selected Files T
iCOn in the too|bar_ =R - anFn\clujd TAra Daownload All Chrb+Shift+HH
Alder B 8
. ) Uﬁﬂ'ﬂc Edit & ffad Templates... ChrT
Select the destination upload |
IiderE | croate fsend Job Data. .
folder on the recorder. %: 61 | ot e clor s
When the folder list box appears, select 4 esfloe Tray i
i uttfx s
the folder then click the [OK] button. %;’e;t S A om0l osdom
Docrlfsnts

Upload complete.
Once the transmission screen closes and the record/play indicator lamp on the recorder is
NOT, upload is completed.

As a shortcut, you can drag and drop files from the Dictation List View to the recorder’s folders
displayed in the Device Tree View.

Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.

19p1093Y 0} Hd wouy Buipeoidn =
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2 Rewnetn Edit - FolderAMIS400003 1, dss
Pl Gt Took beb
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| Recording a new file |

From the DSS Player main window,
click the [File] menu, then select [New

File], or click the _&] icon.
[Remote Dictation] window appears.

Press the! ® | (record) button in the
[Remote Dictation] window or move
the slide switch on the recorder to the
REC position to start recording.

Press the . =  (stop) button or move
the slide switch to the STOP position
to stop recording.

Direct Recording/Editing on PC

You can easily record on the PC directly using the recorder and the DSS Player. While the
recorder is connected to the PC with the USB cable, the Remote Dictation window in the DSS
Player allows you to create a new recording or edit an existing recording. The recorder will act as
a sophisticated microphone with the slide switch and buttons controlling the recording or editing
process. See the Online Help for details.

o Mewindes || o) Delece inden| oM Erase Range| o# Erme | L} Eno

Remote Edit

o " * o v

Editing existing files |

From the DSS Player main window,
select the file you want to edit from
the Dictation List View.

Click the [File] menu, then select

[Edit File], or click theglicon.
[Remote Dictation] window appears.

Edit the recording using the
recorder buttons and slide switch.
You can use the mouse connected to your PC
and the Record and Playback controls to edit
recordings.

Notes
« If you open the [Remote Dictation] window while the recorder is connected, the function of the recorder is changed to

Audio device from Storage device automatically. The recorder as AUDIO device is not displayed as a removable drive
on your PC. Closing the [Remote Dictation] window and retumning to the main screen will switch the recorder back to

storage class device displayed as a removable drive.

* You cannot edit WAV files.
* For DSS Player for Mac, the editing functions are partially limited.
62 * The maximum recording time per file is 99 hours.



Changing User ID (Author ID)

User ID can be uploaded to the recorder using the DSS Player. Up to 10 IDs can be uploaded to

the recorder.

From the main window, click the
[Download] menu, then select [Create &
Send Job Data]. The [Create & Send Job
Data] window appears.

Enter your user ID in the field indicated by the
arrow.

Click the [Transfer] button.
The new user ID will be transferred to the
recorder.

Sae

53000 Prcety Level

Transfer INgID

Cancel

Note

NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you

do, the data on the card will get destroyed.

(a1 Jouany) i Jesn Buibueyn =
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Changing a Folder Name

The folders in the software and recorder can be renamed to reflect the type of recording they will contain.
For example, Folder A might be used to store private information and thus be renamed PRIVATE, while
Folder B might be dedicated to holding business information and thus be renamed BUSINESS.

Changing a folder name in the software
You can change a folder name in the Dictation List View using the [Rename Folder] command
from the [File] menu. Afolder name can be up to 20 characters long and cannot use \ /:*?"<>|.

Changing a folder name in the recorder
Right-click the folder in the Device Tree View to be renamed, select the [Rename Folder] and
input the new folder name.

The name of the folder on the recorder will be updated with the new folder name automatically.
Device Window folder names consist of a string of 8 or fewer alphanumeric characters.

Editing File Comments

You can use your DSS Player to create/edit comments, then transfer them from the PC to the
recorder. You can also edit file comments imported from the recorder to a PC.

Click the [Tools] menu, then select [Edit Comment].
File comments can use up to 100 alphanumerical characters and symbols.

Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.



Using Voice Recognition Software (Optional)

Audio set up

When using voice recognition software such as IBM ViaVoice with the DSS Player, it is
recommended that you train your voice recognition software first to learn the characteristics of
the speaker’s voice and the recorder’s built-in microphone for maximum accuracy.

Connect the recorder to your PC, and start the DSS Player.

Change the recorder to AUDIO device.
Follow the procedure in P.69 to change the recorder to AUDIO device.

Click the [start] button, select [All Programs], then select [IBM ViaVoice
VoiceCenter].

From the IBM [ViaVoice VoiceCenter], [Fiimm e, X
select [ViaVoice], [Tool], then [Analyze
My Voice]. The ViaVoice User Wizard S ML AV L
window appears.

Please type a description for your voice model, or select one
from the Woice Model lst

UserName: — [osono

Device:;

From the [Device] list box, select [Olympus .
DSS File] or [Olympus WMA File]. :
Select [Olympus DSS File] or [Olympus

WMA File] in the [Device] list box, then ; . _
click the [Next] button. < B Okt

Vioice Model  [FirstVoice Model [Dlpmpus DSS File] +

Voice

1

Click the [Next] button .
The [Audio Setup Wizard] window
appears.

Next > Cancel

(TeuondQ) asemyos uoiuboaay as1op Buisn =
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Select a sound card

i . Selecting a Sound Card
When the [Selecting a Sound Card] window

The wizard detected multiple sound cards in your spstem.

appears, select [USB Audio Device] for Select the cards to use for ViaVaice.
[Input] and follow the instructions on screen.

(Select [Microphone Control (DVR)] for Sound Cards

Windows XP.)

Input:

Proceed with the AUDIO Setup
according to the instruction on screen.
During audio setup, enroliment, please input

voice data from the recorder. Hutput
Speaker Controll DR ] j

It is recommended that you enroll while in your normal surrounding environment settings.
This will help improve the voice recognition by registering your voice characteristics and your
environment.

Notes
* Windows 98SE or later OS is required when using voice recognition function with the recorder.
¢ DSS Player for Mac is not compatible with IBM ViaVoice on Macintosh.



Executing Voice Recognition

The DSS Player provides a link in the menu for IBM ViaVoice Voice Recognition software. You
can easily access the menu and initiate voice recognition on any of the DSS file in the Dictation
List View.

Select the folder.

Select the folder containin g the Fle Edt View Tools Download Y¥oice Recognition Help

dic_tation file you want to process V\{ith H ¢ X = B oW & ®
voice recognition from the Dictation e et/ \
Tree View. = kM il wii
J
Select the dictation file.
Select the desired dictation file to = 8 Pounlsed Tray L WL I%Ff
process with voice recognition from %Fmdw 400002557 DEATAD 2412
the Dictation List View. EE:E:[C’ 7 pd)psennond.dss DoAEn Wiz4iz
Folder E

Start of voice recognition. R e
Click the =) icon. Yl
The voice recognition software 3 Sent tems
window appears and voice recognition Doements

= { evice Manaoer
starts. 7 D

| Noise Canceling Function |

Check [Use Noise Cancel] in the [Voice Recognition]

menu to output voice using the noise canceling function Bk MU ARE RIS

to the voice recognition software. Download Help
s Start Yoice Recognition =
Check the voice recognition software operating manual oice Recognition Rangs b |
for voice recognition functions such as modifying converted >

characters. ——  Automatic Playback
Show Progress

(TeuondQ) asemyos uoiuboaay as1op Buisn =
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— Notes on Recording For Voice Recognition

When recording voice to be processed
with voice recognition, set up your
DSS recorder as follows to improve
recognition accuracy.

e Set the microphone sensitivity to
“DICTATION” (== P.35).

¢ Set the recording mode to “SP” (= P.35).

¢ Set the Variable Control Voice Actuator
(VCVA) to “OFF” (= P.27).

* Register/enroll your voice in the voice
recognition software using the recorder.

* Record in a relatively quiet environment.

* Have the recorder microphone 3 to 4
inches away from your chin.

* Speak normally.

e |t is recommended to use the noise-
cancellation microphone, ME12, when
recording.

Dictation files recorded under the
following conditions cannot be
processed by voice recognition because
their recognition accuracy rates will be
very low.

* A conference or meeting where many
voices are recorded.

e Seminar or lecture where high-level
ambient noise tends to be recorded.




USB Microphone/USB Speaker (USB AUDIO)

The recorder can be used as a USB speaker or microphone when connected to a PC. If you use the
recorder as a USB speaker, you can output voice through the recorder instead of using the PC speaker.
When used as a microphone, you can record voice on your PC using you favorite application.

Click the H icon in the toolbar to change the recorder to Audio device.

@D os x

From the [Tools] menu, select [Change to audio device].

Notes

* USB audio function cannot be used with Windows 98 or Mac OS 9.x. The USB audio function is available
only with Windows 98SE and later versions or Mac 0OS10.1.5 and later versions of OS.

* For Mac OS, 0S10.1.5 or later versions support the USB speaker function only. Mac 0S10.2.7 or later
versions support the USB microphone function as well.

* |f you switch the recorder to Audio device, the recorder does not function as Storage device, and it is not
displayed as a removable drive.

(o1anv gsn) 1exeads gsn/euoydosoiy asn =
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Sending Dictation Files/Receiving Document Files

DSS Player software can send dictation files to a third party by e-mail or FTP. This process can be automated
by configuring the DSS Player with the recipients profile information and the sending method.

Setting the E-mail/FTP Service

E-mail/FTP service needs to be set to send/receive files. Set the E-mail/FTP service in P.75-81.

Setting the Auto-Sending Function

To send downloaded dictation files automatically, follow these steps to set the auto-sending
function. This function can be individually set for the folders in the Dictation Tree View.

From the [Tools] menu, select [Options], [ —————— |
then click the [Send] tab in the Option fresd Desclel BN 4 [Pctie] Sl [l
dialog box.

Check [Enable auto-sending function].

Select a folder to set the auto-sending
function, and check the check box.

Select the sending method.
Click the [E-mail] button for selecting an E-mail e
address. :
Click the [FTP] button for selecting an FTP profile. Sl )

[ o J[ Comi ]




|Setting the E-mail destination |

1

3

Click the [E-mail] button.
The [E-mail destination] dialog box
appears.

i

[
St
Nk

[

Click the [To] button.
The [Select recipients] dialog box appears.

Select the recipient names from the

Address Book.

At least one recipient is required in the [To:->]
field. The [CC:->] and [BCC:->] selections are
optional.

Click the [OK] button to finish. If the recipient
information is not present in the Address Book,
use the [New Contact] button to add new
contact information to the Address Book.

Fod kb

manbge  ManageEhegut com
enacrbedSolmpus com

4 3

=]

[

| Setting the FTP destination |

1

3

Click the [FTP] button.
The [FTP destination] dialog box appears.

e e

FTPAddess | Logl. | Audo fes bokder

Click the [To] button.
The [FTP Profiles] dialog box appears.

Select a profile from the list.

One profile can be selected. Click the [OK]
button to finish. If the correct profile does
not exist, select the [E-mail/FTP] tab in the
Option dialog box, and add the profile file
for the FTP connection.

FIP Profies =]
2uabo s bokier

(S ]
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Setting the Document File Retrieve Function

From the [Tools] menu, select [Options], then click the [Receive] tab in the

Option dialog box.

Check the [Use collect back documents
functions] check box.

Select a protocol to be used for receiving
a document file.

If the transmission profile setting is not configured,
configure the setting in reference to P.75.

Register the format of a document file
to receive.

When using E-mail to receive a document file, the
recorder receives the attached file if it is in the
registered file format.

When using FTP to receive a document file, the
recorder receives the attached file stored in the folder
of destination server if it is in the registered file format.

Any document file associated with a dictation file
sent from a transcriptionist using the DSS Player
Pro Transcription Module Release 4 or later is
received regardless of this setting.

onianal dctston,

] Erstle FTP

Tyea of documents o ba racaived

] Pleceive: documents sent by an sppkcation cther than D55 Player
Add s scdirsion or the s b ba racaived

Display ok is changad ¥ Docurnant it rit sark hack
[ alten the holwmrsg dhays: e chitnbuaion of Dictabe
clapaed




Sending Dictation Files

|Sending Dictation Files Manually |

Select the dictation file you want to send
from the Dictation List View.

To select more than one file, press and
hold either the [Ctrl] or [Shift] key and
make your selection.

Right-click the dictation file, and
select [Send File].

Select E-mail or FTP for the sending
method.

Confirm the contents of the
transmission template, and click
the [Send] button.

| Receiving Document Files Manually|

In the toolbar, click the [Send/Receive

files] icon €.

According to the profile set, the application
establishes a connection to the server and
receives document files. The received
document files are saved to the Documents
folder in the Dictation Tree View.

Clicking the [Display Dictations & Documents]
icon | in the toolbar displays dictation files
and document files at the same time. By
dragging and dropping a document file to a
dictation file, the document file can be
associated with the dictation file.

The document file sent as a reply from a user
(transcriptionist) who uses the DSS Player
Pro Transcription Module Release 4 or later
will be automatically associated with the
dictation file you originally sent to the user.

so|14 Juswnooq BulAI9oaY/Sa|I4 uoneldlg Buipuss =
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Sending/receiving Automatically |

You can set the application to make a connection to the server at the certain interval for sending
dictation files and/or receiving document files.

From the [Tools] menu, select [Options], then click the [General] tab in the
Option dialog box.

Check [Auto-send/receive], and enter the time interval of automatic attempts
of sending and receiving.

Set the auto-sending function and the document file retrieve function
according to the instructions on P.70-72 respectively.

Dictation files are stored in the Message folder on the hard disk. If you want to send a dictation
file by attaching it to e-mail, select the file from the Message folder.

The Message folder location can be found by selecting [Options] from the [Download] menu.

Playing Received DSS Files

When sending DSS files to a user who does not have the DSS Player software, the user will not
be able to play the received DSS file. A free DSS Player from Olympus, DSS Player Lite, can be
downloaded from the Olympus website at:

http://www.olympusamerica.com/cpg_section/cpg_downloads.asp
http://cf.olympus-europa.com/consumer/voice/downloads/downloads.cfm



Setting E-mail/FTP Service

When using E-mail and/or FTP to send dictation files attachments and/or retrieve typed
documents, it is important to configure the E-mail/FTP service in the DSS Player to match that of
the E-mail/FTP program you have configured on your PC. Please consult with you system
administrator if you need help with setting your E-mail/FTP service.

From the DSS Player main window, click the
[Tools] menu, select [Options], then click the
[E-mail/FTP] tab.

Create a profile which specifies the
destination.

A profile must be created for each account to be
connected.

To create a profile, select the sending method, and click
the [Setting] button.

When E-mail is used to send and/or receive files, select
the type of E-mail service used on your system.

Internet E-mail

Gienesal | Dowrlend | EMAUFTF | Sond | Aneons | Bachus | Foldess

E-mail service Option

Emal
) Intemet E mad [FUF, SMTR)

Corlgurn D55 Ployet Pris b corwwed ey 1o E-reesd S
Inkesriet stardards foe emad debvenPOF SMTRL

SMTP/POPT Profile: | Shympus po

7 Conporah of Wokgroup [MAFI Comghand]

TP Prosie shymgust fip v

Select when using E-mail, connecting to POP3 or SMTP server via internet service provider.

| Corporate or Workgroup

Select when using MAPI Compliant services such as Microsoft Exchange, Lotus Notes or
Group Wise. For details on the setting procedure, see P.76.

Select a profile.

When the setting is complete, click the [OK] button to enable the setting.
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Setting Connection for MAPI Compliant Service

Click the [start] button of Windows OS, select [Settings], then [Control Panel].
The [Control Panel] appears

Check whether the [Mail] or [Mail and Fax] icon is present in the Control
Panel.

If the icon exists, the MAPI subsystem has already been installed on your computer. Go to the
“Activating Send Mail Function (Create a Profile)” section in this manual (== P.80).

If the icon does not exist, install the MAPI subsystem. The MAPI subsystem will be installed
when Microsoft Exchange Client, or Microsoft Outlook is installed.

Microsoft Outlook is included in the Microsoft Office.

Installing MAPI Subsystem

When the following window appears,
select [Corporate or Workgroup] and
Start the Setup program for Outlook 98. click the [Next] button.

When the following window appears,
select [Other Mail Applications] and click
the [Next] button.

| Installing Microsoft Outlook 98 |

E-mail Service Options

g e
LA e

Whm-ul-'mnmmmh

K el debvery POPI. SUTP, or

E-mail Upgrade Options L G Wk g
W?nmamamtmm
addhen bochs, and selings . mmmwnmcn
T Mafmad

ot Chutiock, o et clats and eiings hom ore of thecs. D rocd st Dhutnch. b s sl | o et w0 | -

rogpams, choh More of e above. ancthes pacgam o sead el

S

—e— Follow the instructions on screen.




| Installing Microsoft Outlook 2000 3 A dialog box for setting up Microsoft

Outlook appears.
After installing Outlook 2000, start the This is th'e wizard forqreating a profile. For
program information on creating a profile, check
When th 'f lowi ind lick step 3 in the “Activating Send Mail
en the following window appears, clic Function” (= P.80).
the [Next] button.

Select [Corporate or Workgroup] and
click the [Next] button.
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| Installing Microsoft Outlook XP/2003 |

After installing Outlook XP, double-
click the [Mail] icon in the [Control
Panel], and then click the [Show
Profiles...] button.

W e Dt ..
oty
Q s . T vy e
o ) e Show Profies...
=

Click the [Add...] button.

T =

Gerd |
@mwm\h-uwmﬁm
El
| Remoe | Popete | con |
when slartng Moo Dulioch. wee this protle.
1 Prompi bar 3 paciie 5o e used

 Hlnaps use i rokle

e ——
[or ] _omn | |_wwe |

Type the profile name and click the
[OK] button.

New Praofile x|

Create New Profile
Cancel
Profile Marme:

Lotus Mokes]

Select “Add a new e-mail account”
and click the [Next] button.

ST s
-l A comants. ) G

Emad
% Aekda v -l acsmurt

£ o o change axisting el aceourts

Durectary
Ak a e ivectony or ket bock
£ i o change axisting desctones or adkress books

| BT (] W

Select your e-mail server type.

If you are going to use an MAPI compliant
Workgroup system such as Lotus Notes
or Novell GroupWise, select “Additional
Server Types”, click the [Next] button to
continue. If you are going to use an internet
standard E-mail account, select “POP3”
server, click the [Next] button, and skip to
step 7.

femannccomts 2
Serves Type G
1 Picresolt Exchange Server
hare dorts.
 ros

Connect 2 8 POP #-md sarves b domricad
your emal.
" pap
Conrwct ta an AP -l sarvar 1o downlond s-sad and smchronos
e ks,
« me
syrchrorios sadben Fokders.

% Rkbiiomal Sevver Types
Cormect 1 acther werbgrous e Jrkparty sl server.

o [ ] _on |




If you select “Additional Server
Types”, you will see the following
dialog box.

Click the [Next] button and follow the
instructions on the screen, then skip to step 8.

femannccomts EIE:|
Addtional Serves Types. G
e onal st types. Select the
Ve By you wank to conrect to and dick.
Addtirel e Types
o [ ] _on |

If you select “POP3”, you will see the
following dialog box.

Enter the necessary information and click
the [More Settings...] button.

= Tost oot Swtngs .|

[P o]

Back. Pt

Careel

8

Click the [Connection] tab in the following
dialog box and make sure the appropriate
connection method is selected.

Jirerenet (st Seitimos S 1=
Geresdl | Duagerg Server orrmttion | avarsced |
’ﬁ“mhwdwmmh“
Connwction

1 Connect s ey lcal e rterk (L4
|
¥ Connact sing ey phone ine
" Connect using st Explorer's or  Srd party dler
Hodem
Ut Folloeang Dis-Lp Mebworkang conrection:
[om ez =]

] e |

After the setup is completed, click
the [Tools] menu, select [Options],
then click the [E-mail/FTP] tab.
Select the MAPI profile name you
have created.
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Activating Send Mail Function (Create a Profile)

The Profile is the group of information services to set up the Messaging application. The information
services allow you to access the Mailbox and the Address Book. The Send Mail function will not
work if there is no profile. If the profile exists and has already been used for sending E-mail, it is
not necessary to create a new profile.

Start the DSS Player and click the [Tools] menu, select [Options].

In the Option Setting dialog box, click the [E-mail/FTP] tab and select the
profile name you want to use.

Click the [Setting] button. Microsoft Outlook Setup Wizard
The Setup Wizard runs and will list the
messaging applications that comply with
MAPI. For example, if groupware such as
Lotus Notes, Novell GroupWise, or Microsoft
Exchange is installed, these applications will
be listed.

Select the information servicels] that you want to use
vith Microsoft Dutlook

¢ Use the fallowing information services

Select [Use the following information
services] and check one application
from the list.

If you want to set up a dialup connection e Loneel
through an internet service provider, select
[Internet E-mail] in the list. If you want to
set up to use a LAN within your company,
also select [Internet E-mail] in the list.
Note

The Send Mail function does not work with
AOL or internet service providers that
cannot open POP3 server addresses.

 Manually canfigure information services




Click the [Next] button and follow the instructions on the screen.

When the wizard is complete, it returns to the profile in the Option Setting
dialog box.

Please make sure that the profile name you have created using the Setup Wizard is
displayed in the Option Setting dialog box. If a different profile name is displayed,
switch to the profile you have created.
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Using the Recorder as a Reader/Writer

When the recorder is connected to your PC, it will be recognized on your PC as a removable
drive. You can view and access the recorder card from My Computer and download data from
the card to your PC using standard windows copy/move and delete commands. You can also
upload data from the PC to the card in the recorder in the same way.

* In Windows 98/ 98SE, you must have the DSS Player software installed for the recorder to be recognized.

Example: Copying Data from PC to Card Using Explorer or Finder
Start Windows.

Connecting the recorder to your PC.
For connection procedure, refer to “Connecting to Your PC Using the USB Cable” (== P.53).

Open Windows Explorer or Finder window.
The recorder will appear as a removable drive icon.

Copy data to card.
While the data are being written or copied, the record/play indicator lamp on the recorder will
flash.

Note
NEVER remove the card or disconnect the USB cable while the record/play indicator lamp is flashing. If you
do, the data on the card will get destroyed.



Alarm Message List

Message Meaning Explanation Action
BATTERY LOW  Low battery Battery power is getting low. Charge the batteries or replace
power with new batteries (P.13-15).

FILE Erase-locked Attempt to delete a locked file.  Unlock the file (s= P.37).

IS LOCKED

INDEX FULL Index full The file is full of index marks Erase index marks that are no
(maximum of 16 marks). longer required (== P.38).

FOLDER FULL Folder full The folder is full of files Erase unnecessary files (= P.31).

(maximum of 199 files).

Maximum number

The destination folder already
has the maximum number of
files (199).

Erase unnecessary files (== P.31).

MEMORY
ERROR

Incompatible card

An incompatible card was
inserted.

Insert a compatible card.

MEMORY FULL

Zero remaining
memory

The card has no remaining
memory.

Erase files that are no longer
required or insert another card.

FORMAT Formatting error There was an error while Reformat the card (== P.46).

ERROR formatting the card.

SYSTEM System error System error detected in the This is a malfunction. Contact

ERROR recorder. the place of purchase or
Olympus Service Center for
repair.

INSERT CARD No card There is no card inserted. Insert a card (== P.21).

CARD COVER  Card coveris The card cover is not closed. Close the card cover securely

IS OPEN opened until it click (= P.21).
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Troubleshooting

Symptom

Probable cause

Action

Nothing appears
on the display

The batteries are not loaded properly.

Verify polarity is correct (= P.13-14).

The batteries are dead.

Replace with new batteries (== P.14).

The recorder is in power off mode. Turn the recorder ON
(= P17).

Won’t start The recorder is in power off mode. Turn the recorder ON
(= P.17).

The batteries are dead.

Replace with new batteries (= P.14).

Unable to record

The card does not have enough memory.

Erase unnecessary files or insert
another card (= P.10, 31).

The card is unformatted.

Format the card (v P.46).

The maximum number of files has been
reached.

Check another folder.

No playback tone
heard

The earphone is connected.

Unplug the earphones to use the
internal speaker.

The VOLUME button is set to 0.

Adjust the VOLUME button.

Unable to erase

The file is locked.

Unlock the file (= P.37).

Noise heard
during playback

The recorder was shaken during recording.

The recorder was placed near a cell phone
or fluorescent lamp while recording or
during playback.

Move the recorder.

Recording level
too low

The microphone sensitivity is too low.

Set the microphone sensitivity to
CONFERENCE mode and try again (== P.35).

Unable to set
index marks

The maximum number of index marks (16)
has been reached.

Erase unnecessary index marks
(= P.38).

The file is locked.

Unlock the file (== P.37).

Cannot find the
recorded voice

Wrong folder.

Switch to the right folder.

Cannot connect
to PC

Some PCs and USB hubs may not provide
sufficient power.

Turn the USB CHARG. “OFF” in the
recorder’s menu settings (= P.35).

Cannot connect
to a PC using a
cradle

Sometimes a connection cannot be made
with some PCs running Windows XP.

You need to change the PC’s USB
settings. See DSS Player online help
for details (= P.52).




Accessories (Optional)

xD-Picture cards of 16, 32, 64, 128, 256 and 512 MB: M-XD16/32/64/128/256/512
Olympus CAMEDIA digital camera series xD-Picture Cards can be used.

Headset: E102

Stereo headset for your PC. A helpful tool for PC based transcription.

Monaural binaural earphone: E20

Noise-Cancellation microphone: ME12 (Dictation microphone)

Used to get crisp recordings of your own voice by reducing the effects of ambient noise.
Recommended to improve the accuracy when using voice-recognition software.

External microphone: ME15

A lavalier omnidirectional microphone that clips to clothing. Used to record your own voice or
people near you.

PC Transcription kit: AS-4000
The AS-4000 transcription kit (sold separately) provides you with a PC-footswitch, a headset and DSS
Player Pro Transcription Module for easy transcription of DSS recordings.

Foot switch: RS25/26
Connect to the serial or USB port of your PC for hands-free transcription convenience.

USB Reader/Writer: MAUSB-10 (Dual-Slot xD-Picture Card & SmartMedia)
Allows data to be transferred to and from a PC.

USB Reader/Writer: MAUSB-100 (xD-Picture Card)
Allows data to be transferred to and from a PC.

PC Card adapter: MAPC-10 (xD-Picture Card/SmartMedia)
Allows data to be transferred to and from a PC that has a PC card slot.

Connecting cord: KA333
Use to connect the microphone jack of this unit to a radio or other sound source.
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Specifications

Recording format
DSS (Digital Speech Standard)
Recording media
xD-Picture Card: 16 to 512 MB
Input level -70 dBv
Sampling frequency
SP mode: 12 kHz
LP mode: 8 kHz
Overall frequency response
SP mode: 300 to 5,000 Hz
LP mode: 300 to 3,000 Hz
Recording time (32 MB Card)
SP mode: 5 hours 10 minutes
LP mode: 11 hours 5 minutes
Alkaline battery life
Recording: Approx. 16 hours
Playback: Approx. 9 hours
Ni-MH Rechargeable Battery life
Recording: Approx. 12 hours
Playback: Approx. 8 hours
Speaker
Built-in 28 mm round dynamic speaker
MIC/EAR jack
3.5 mm mini-jack, impedance MIC 2 kQ,
EAR 8 Q or more
Maximum working output (3 V DC)
180 mW or more (8 Q speaker)
Input power requirement
Rated voltage: 3V
Batteries: Ni-MH Rechargeable Battery Pack
(BR402) or Two AAA batteries
(LRO3 or R03) or Two Ni-MH
rechargeable batteries (BR401)

External dimensions
110.2 x 50.0 x 16.9 mm
(without protrusions)
Weight
103 g
Including Ni-MH rechargeable battery
pack (BR402)

* Specifications and design are subject to
change without notice.
* Battery life is measured by Olympus. It

varies greatly according to the type of
batteries used and the conditions of use.



Technical Assistance and Support

DS-4000 is part of the Olympus Professional Dictation System. Your dealer is trained to troubleshoot
and fix many common problems that you may be having with this system. If you encounter problems
using your DS-4000, we recommend that you contact your Olympus Professional Dealer that sold
you the system. If your dealer cannot fix your problem, please call our technical hotline number or
send an E-mail.

@ For customers in the U.S. and Canada
Phone: 1-888-553-4448
E-mail: distec @ olympus.com

@ For customers in Europe
E-mail : dss.support@ olympus-europa.com
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OLYMPUS'

OLYMPUS CORPORATION
Shinjuku Monolith, 3-1 Nishi-Shinjuku 2-chome, Shinjuku-ku, Tokyo 163-0914, Japan. Tel. 03-3340-2111
OLYMPUS AMERICA INC.
Two Corporate Center Drive, Melville, NY 11747-3157, U.S.A. Tel. 1-800-622-6372
OLYMPUS EUROPA GMBH
(Premises/Goods delivery) Wendenstrasse 14-18, 20097 Hamburg, Germany. Tel. 040-237730
(Letters) Postfach 10 49 08. 20034 Hamburg. Germany.
OLYMPUS UK LTD.
2-8 Honduras Street, London EC1Y OTX, United Kingdom, Tel. 020-7253-2772

http:/ /www.olympus.com

Declaration of Conformity

Model Number: DS-4000

Trade Name: DIGITAL VOICE RECORDER

Responsible Party: OLYMPUS AMERICA INC.

Address: 2 Corporate Center Drive, Melville, NY 11747-3157, U.S.A.
Telephone Number: 800-622-6372

This device Complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

C Tested To Comply
With FCC Standards

FOR HOME OR OFFICE USE
Canadian RFI

This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus
as set out in the Radio Interference Regulations of the Canadian Department of Communications.

Cetappareil numérique ne dépasse pas les limites de Catégorie B pour les émissions de bruit radio émanant d'appareils
numériques, tel que prévu dans les Reglements surFInterférence Radio du Département Canadien des Communications.

“CE” mark indicates that this L'indication “CE” signifie que ce Das ,CE" Zeichen bestatigt die
product complies with the produit est conforme aux Ubereinstimmung mit den

European requirements for exigences concernant la sécurité, Europaischen Bestimmungen
safety, health, environment and la santé, I'environnement et la far Betriebssicherheit und
customer protection. protection du consommateur. Umweltschutz.
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